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Création d'un service web avec NetBeans 5.5 et SJAS 9

1. Présentation

L'objectif de ce document est d’expliquer la création et I'utilisation d’un service web avec NetBeans 5.5 en
respectant la norme JAX-WS 2.0.

2. Creéation d’'un service web avec NetBeans

2.1.Création d’'une application Web

Obijectifs : Mise en place du container web du serveur d’application (SJAS). Il contiendra le site web JSP par
défaut (non utilisé dans notre exemple) et nous allons y intégrer un service web.

File > New Project > Web > Web Application

E|New Pro ject
Steps Choose Project
1. Choose Project Categories: Projects:
20 ~7) General =/ W'eb Application

3 Web WWeb aApplication with Existing Sources
[F web application with Existing Ant Scripk

IC2) Enterprise
) Service Oriented Architecture
) MetBeans Plug-in Modules

F-0) samples

Description:
Creates an emplty Web application in a standard IDE project. A standard project uses an
IDE-generated build script ko build, run, and debug your praject,

l Cancel H Help l

Choisissez le serveur d'application sur lequel devra étre déployé le service web : Sun Java System Application
Server 9 (SJSAS) et Java EE 5.
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£ | New Web Application

Steps Mame and Location

L. Choose Project

Project Mame: iWeb.ﬂppIris

2.  Name and Location

3. Frameworks Project Location: |D:'I,Tapiris'l,PrDjets_netbeans

Project Folder: ID:'I,Tapiris'l,PrDjets_netbeans'l,WebP.ppIris

Source Structure: |Java BluePrints ~ |

&dd to Enterprise Application;

Server: iSun Jawa Syskem Application Server 2

Vl[ Manage... ]

Java EE Version: |-Java EES b .

Corkext Path:  |[webapplris

Recommendation: Source Level 1.5 should be used in Java EE 5 projects,

Set Source Level ko 1.5

Set as Main Project

[ < Back, ][ MNext = ][ Einish

”_ Cancel ][ Help

Aucun Frameworks de sélectionné pour le moment.

E | New Web Application

Steps Frameworks

1. Choose Project Select the Framewaorks you wank ko use in your web application.
2, Mame and Location

3. Frameworks

] struts 1,24

Cliquez sur Finish.

NetBeans créé une application web contenant déja une page index.jsp :
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NetBeans IDE 5.5 - WebApplris
File Edit ‘“iew MNavigate Source Refactor Build Run CY¥S Tools  Window Help

CRE@ 2@ e P B Db P

5 ‘Projects 40 % ‘Fjl ‘Runtime @index.jsp 3 > | |:Palette o %
§ = @ webApplris P - R A O A = HTML
& =03 Web Pages == = = EE Table [E]# crdered List
@ i El WEB-INE <%Epage contentType="text/html %> Al
5 idexi <%Epage pageEncoding="UTF-8"%> Unardered List  [4] Image
index.js
corfi t]_ DFI - =2 Lirk, =] Meta data
@ oniguration Fles The taglib directive below imports the JSTL library. If you uncomment it, = HTML Forms
@ Server Resources you must also add the JSTL library to the project. The Rdd Library... acti E| i Taxt Input
i@ Source Packages on Libraries node in Projects view can be used to add the JSTL 1.1 library

(8 TestPackages Multi-line Input =) Drop-dawn List

@ Libraries Chedkbox (®) Radio Buttan
01 10K 1.6 (Default) File Select Button
S Sun Java System Application Server 9 = ISP

Test Libraries
@ () Use Bean

'DOCTYPE HTML PUBLIC "-// DTD HTML 4.01 Transitional//EN"

"hetp: /e w3, or g/ TR/html 4/ dtd” E¥A Get Bean Property
@ Set Bean Praperty
<html>
E <head> {5 15TL Choose
<meta http-squiv="Content-Type” content="text/htnl; charszet=UTF-8" n{: JSTLIF
<title>J3F Page</title> D@ 3ISTL For Each
r </head> EREE
=] <body>
[T] 25F Form [EEH 25F Data Table
<h1>JSP Page</hl> = Database
@ DE Query |- | OB Report
B [P DB Insert 5 DB Update

This example uses JSTL, uncomment the taglib directive above.

To test, display the page like this: index.jsp?sayHello=true&name=Hurp % EEREEE

E -
<c:if test="${param.sayHello}">
<l-- Let's welcome the user ${param.name} -->
Hello ${param.name}!
<fc:if>
r ——%

o </body>
L </ntal>

¢ | =
141 s

€

@

2.2.Création du service web

Clic droit sur le projet > New > File/Folder > Web Services > Web Service

Steps Choose File Type
1. Choose File Type Project: | () Wehtpplris N |
2.

Categories: File Types:

Logical Handler
Message Handler
WSDL

Weh -~
Enkerprise
Java Classes

JavaBeans Objects
JUnik

Persiskence

Web Services |
Sun Resources

Sun CMP Deplayment Artifact: |
H || |

Web Service Client
Web Service From WwSDL

Descripkion:

Creates a skeleton web service, Web services are reusable software components that semantically
encapsulate discrete Functionality, Web services are accessible over standard protocols such as
SOAP, The web services created by this template are deployed and run according ko the 15R-109 and
JZEE 1.4 standards,
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Entrez le nom du service web : « WebServicelrisl »
Entrez le nom du package dans lequel doit étre créé les classes du service web : « com.iris »

Remarque : Pas de doublon de nom du service web sur le méme serveur d’applications

| New Web Service

S5teps Name and Location

1. Choose File Type Weh Service Name: |webServicelris1 |
2. Name and Location

Project: IWebﬁ.ppIris |

Location: | Source Packages ~ |

Package: |c0m.iris| e’ |

@ Create an Emply Weh Service

O Delegate ko Existing Session Enterprise Bean

Enterprise Bean: B

Cliquez sur Finish

£ NetBeans IDE 5.5 - WebApplris

File Edit View Mawvigate Source Refactor Build Run C¥S  Tools Window Help
5 B T L r | E
CCE@R s2anc/p @ P oD
5 |/Projects @ x |:Files :Runtime Bl indexcjsp | @) webServicelrisl.java % | -
m -
‘WebAppl B = = = L=
- JISEE B viebapplris = | 0 TP R EE @ @
i L3 web Pages
o5 i Alm
-10) WEB-INF =
* WebServicelrisl.java
@ index.jsp .
@ Web Services * Created on 23 janvier 2007, 12:04
WebServicelris1 .
& Configuration Files * To change this template, choose Tools | Template Manager
@ Jerver Resources * and open the template in the editor.
0@ Source Packages -y
B com.itis
----“"'lWebServiceIrisl.java package com.iris;
0@ Test Packages
& Librarias Elimport javax.ijws.WebService;
7121 10K 1.6 (Default)
#-5  5un Java System Application Server 9 f**
(2 Test Libraries '
* Bauthor administrateur
[WebService()
H public class WebServicelrisl |
} v
1:1 |
g
=

Aprés la création du service web, NetBeans signale une erreur sur la classe WebServicelris1 tant qu’aucune
méthode n’a été créée.
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2.3.Ajout d’'une méthode au service web

Dans l'onglet projects > Dossier Web Services > Clic droit > Add Operation

| NetBeans IDE 5.5

File Edit Miew Mawigate Source Refactor Build Fun WS Tools  Window  Help

PCEB@ Ffsamnampe @, 2

5 |Projects 4 x ]EFiIes : Runtime 5 index.jsp % | @)™ WebServicelrisl java %
m -
o | [ WebApplris = | B B
& |=-@ Webapp € > [RAFEH|% L%
= I_‘—j@ Web Pages
H-13) WEB-INF )
E D * WebServicelrisl.java
- @ indez:. isp R
EI'"@ Web Services * Created on 23 janvier 2007,
L [ .
) . Cpen
E""@ Configur atio P * To change thiz template, chd
""" 1@ Server Reso * and open the template in the
EIM[:E Source Pack Add Operation. .. *
= com.iris
....IE'EWEt Test \Web Service |ackag'e com. iris;
-0 TestPackad  pyp oot copvice Attributes _ , ,
EI@ Libraries mport Jjavax.jws.Weblervice;

|;|] oK 1.6 Configure Handlers. .,
5 Sun Jav
-8 Test Librarie

Delete Supprimer |«

* [author administrateur

Properties

Ajoutez la méthode direBonjour() en respectant I'écran suivant :

r
& Add Operation

Method

Mame: |direBu:unj-:uur |

Return Type: |String V| [ Browse, .. ]

Input Parameters and Exceptions

Parameters | Exceptions

Objects:

Voici le code généré avec les annotations « web services » commengant par le caractere @ (spécifications du
package javax.jws de Java EE 5)
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@webMethod

public String direBonjour(@WebParam(name
// TODO implement operation
return null;

"prmNom'™) String prmNom) {

Ajoutez le code suivant a la méthode :

@WebMethod

public String direBonjour(@WebParam(name =
String s = """ ;
s = "Bonjour " + prmNom ;
return s ;

}

"prmNom™) String prmNom) {

3. Génération des javadocs

Pour respecter la norme de création des services web, il faut générer

Clic droit sur le projet > Generate Javadocs for project

| NetBeans IDE 5.5 - WebApplris

File Edit Wiew Mawigate Source Refactor  Build  Run
Iy 3| o = » ]
|_ LI_ Ej -, - | = 1" 1
s |:Projects 40 = ‘Files : Runtime
m
2 E@ E' M *
5 5@
F-if Build Project
“f Clean and Build Project
=@ Y Clean Praject
I‘:'IllI Werify Project
| Generate Javadoc for Project

les javadocs du projet.
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2 com.iris - Microsoft Internet Explorer |'._||'E|[z|
Fichier  Edition  Affichage  Faworis  Oukils 7 .1.’
- — i . — b
@ Frécédente - e - \ﬂ @ __l\] P ! Rechercher “f;:(’ Fareoris Q‘E < = “‘-—;
Adresse @ D1\ Tapiris\Projets _netbeansiwebapplrisidistijawadoctinde:. htrml b (]9 Liens **
All Classes
YWebhServicelris 1 Package Class Use Tree Deprecated Index Help
FREW PACKAGE NEXT PACKAGE FRAMES MO FRAMES

Package com.iris

Class Summary
WebServicelris]

Package Class Use Tree Deprecated Index Help

FREW PACKAGE HNEXT PACKAGE FRAMES HO FRAMES

I@ j Poste de trawvai

4. Déploiement sur le serveur d’application installé avec NetBeans

4.1.Déploiement a partir de NetBeans

Clic droit sur le projet > Deploy Project

4.2.Test du service web a partir de NetBeans
Dans l'onglet « Projects » > Clic droit sur le service web « WebServicelrisl » > Test Web Service
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£ | NetBeans IDE 5.5

File Edt Wiew Mavigate Source Refactor Build Run CYS  Tools  ‘Window Help

LCBE 2 ol Nl = (@, e

s :Projects 40 X |:Files : Runtime @ index.jsp - ™ I wWebServicelrisl.java *
m -

WebAppl B
& |&-© webapplrs EP A FLEH|D L%
i =3 Web Pages oo = - -
{E-C0) WEB-INF *

* To change this template, cl
* and open the template in tl

H @ indezx.jsp
SJ-ILg) Web Services
. tebServicelris

Qpen

@ direBonjoun
I3 Configuration Files
S R i
@ SYEr ResnUres Add Operation. . javax.jws.WebMethod;

e com.iris;

0@ Source Packages
3 @ Test Packages
#-3 Ubraries Edit Web Service Attributes

javax.jws.WebParam;
javax.jws.Web3ervice;

Ce test ouvre une page web qui permet d’appeler la méthode du service web et de récupérer I'adresse du
fichier WSDL (utilisé par les clients du web service)

) WebServicelris1Service Web Service Tester - Microsoft Internet Explorer

Fichier  Edition  Affichage  Faworis  Qukils 7

n

] \__/] |ﬂ @ _h /.._HJ Rechercher ‘-E:\'C’Faw:uris Q} <] ~ .,:; l.)_fl - J ﬁ

¥

Adresse |ﬁ§| https fflocalhost: 8080/ WebapplrisfWebServicelris 1 Service ! Tesker

WebServicelrisl Service Web Service Tester

This form will allow ywou to test your web service implementation (W 2DL File)

To wwrolke an operation, Hll the method parameter(s) mput boxes gdd click on the button labeled wath the method name.

Methods : Clic droit sur le lien > copier le raccourci :
Adresse du fichier WSDL =
public abstract java.lang String com.ins. WebServicel) http://localhost:8080/WebApplris/WebServicelris1Ser

[ direBanjaur ]d b vice?WSDL

Entrez un texte dans la zone de texte et cliquez sur le bouton « direBonjour ». Vous devez obtenir le résultat
suivant :
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2l Method invocation trace - Microsoft Internet Explorer
'+

Eichier  Edition  Affichage  Favoris  Outils 2
. I =
Oprécédente i > ) |ﬂ @ ,l\J 7 ) Rechercher ‘;_:_(Favuris ‘3 o ;_7 Lii QI ﬁ
v| Ok Liens **

Adresse ‘@ http:fflocalhost: 8080/ WebApplrisfwebServicelris1 Service? Tester
~

direBonjour Method invocation

Method parameter(s)

Type Value
java lang String Armentitres

Method retwned

javalang String : "Bonjowr Armentiéres”

SOAP Request

<?xml wversion="1.0" encoding="UTF-872>
<soapenviEnvelope xmlns:soapenv="http://schenas.xmlsoap.oryg/soap/envelope/" xmlns:xsd="http://www.w3d,org/2001/ENMLSchewa”™ xmlns:insl="http://iris.com’ ">

<soapenv:Body:>
<nsl:direBonjour:>
{prmNnm}ArmEntii res</ pruioms:
</nsl:direBonjour>
</soapenv: Body:>
</soapenv:Envelope>

SOAP Response

<?xml wversion="1.0" encoding="UTF-872>
<soapenv:Envelope Xmlns:soapenv="http://schewas.xwlsoap.org/soap/envelope/" xwlns:xsd="http://wvwvw.w3.org/2001/XMLSchewa” xwlns:nsl="http://iris.com/ ">

<spapenv: Body>
<nsl:direBonjourResponses
<return>Bonjour Armentil res</return>
</nsl:direBonjourResponses>
</soapenv: Body:>
</ soapenv:Envelopes

Al | Bl
@1 Terming \3 Intranet local

Le service web est maintenant opérationnel.

5. Utilisation du service Web créé

5.1.Serveur d’application

Vérifiez que le serveur d’application utilisé par le service web est bien démarré.
Dans NetBeans > Onglet Runtime > Clic droit sur « Sun Java System Application Server 9 » > Start
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£ | NetBeans IDE 5.5
5= Edit View MNavigate Source Refactor  Build

W @ e L i 7
(e LI ™ )
= :Projects Files : Runtime
o EIEEI SErvErs

=
o . &2 pundled Tomeat (5 5.17)

D Y | .ﬂpphcatmns
. -3 Enterprise Applications
B -3 ‘Web applications
E| @ webApplris
) defaul
D =p
@ WebServicelris1
i@ amserver
3 EJ& Modules
Ij Connector Modules

[#-03 App Client Module] 2 - onmecror m

#- Resources

5.2.Création d’un nouveau projet client

File > New Project > General > Java Application

B New Project

Steps Choose Project

1. Choose Project Categories: Erojects:

2, ) General
A7) Web

& Java Class L|brary
é,g Java Project with Existing Sources

4 Enterprise s ; o :
=) Service Criented Architecture Java Project with Existing Ank Script

) MetBeans Plug-in Modules
1) Mobile
4 Samples

Descripkion:
Creates a new J25E application in a standard IDE project. You can also generate a main class in
the project, Standard projects use an IDE-generated Ant build script to build, run, and debug

vour projeck,

Finish [ Cancel H Help

Décochez « Create Main Class »
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E | New Java Application
Steps Name and Location
1. Choose Praject Project Mame:  WebServicelrisl AppiiTest |

2.  Mame and Location

Project Location; |D:'|,Tapiris'l,Projets_netbeans H Browse. ..

Project Folder: !F[-)-:'l,_T‘;piris'l,Pr0jets_netbeans'l,WebServiceIris 1AppliTest |

Set as Main Project

[[] Create Main Class Yebae

Création d'une fiche graphique JFrame :

Clic droit sur le projet > New > File/Folder > Java GUI Forms > JFrame Form

=
£ New File
Steps Choose File Type
1. rhoose File Type Project: |@ wWebServicelris1 AppliTest V|
- %ategnries: - File Tl\,_f_p_es:

) web |
----- I Java Classes l
-I) Java GUI Forms
----- 0 JavaBeans Objects
----- =) Junit

----- I Persistence

----- I web Services
£ R

..... 12 Ant Build Seripts

JApplet Farm
| IDialog Farm

JFrams Form

| JInkernalFrame Form
JPanel Form

Eean Farm

Java Package

=

o
o
5
|0 |

Description:

Creates a new JFC (Swing) Frame. Frames are bypically used as standalone top-level windows as the
main user interface to the application. Most Swing applications are builk starting From this Form,

E| MNew JFrame Form @

Steps Mame and Location

'
1. Choose File Type Class Mar |ClassIFrame ) |

2.  Name and Location

Project: iWebServiceIrismppIiTest |

Location: iSnurce Packages w |

Packange: qpqtest ) w |

Created File: ED:'|,Ta|:|iris'|,Projets_netbeansIWebSErviceIris1.C\ppIiTest'l,src'l,pqtest'l,CIassJFrame.java |

Donnez un nom a la classe : ClassJFrame
Créez en méme temps le package « pgtest »
Cliquez sur Finish

Sélection du nouveau JFrame comme classe principale du projet :
Clic droit sur le projet > Properties > Run >Main Class = « pqtest.ClassJFrame »
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Création des composants de I'HM (affichage en mode « Design ») :
En cliquant — glissant de la palette vers la JFrame, créez les composants suivants :

S Tools indow Help
3 TR
@ index.jsp  * ] WebServicelrisl java = | El ClassFrame.java *

— . jTextFieldNom
Source |Design | |_[:3|% |j ="l = % /

[ jButtonl

- —

[ eeel | [EEas jLabelReponse

Remarque : les composants graphiques de la JFrame sont tous créés dans la méthode initComponents().
Cette méthode n’est pas modifiable a partir du code source, NetBeans ne présente pas son code directement,
il est replié dans I'éditeur de code source.

5.3.Intégration du fichier WSDL dans NetBeans

Clic droit sur le projet > New > File / Folder > Web Services > Web Service Client
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| New File

Steps

Choose File Type

1. Choose File Type
2.

Project: | @ ‘WebServicelris 1 AppliTest

Categories: Eile Types:
i) Java Classes
BT Java GUI Farms

----- I0) JavaBeans Objects
----- 1) JUnit

----- ij Persistence

----- I ‘Web Services
= L B

----- I Ant Build Seripts

Description:

Creates a web service client that is compliant with J3R-109,

Cancel

Remplir le champ « WSDL URL » avec I'adresse du fichier WSDL récupéré précédemment
Remplir le champ « Package » avec pgtAccesWebServicelris1l

Cliquez sur Finish

E| New Web Service Client

Steps

WSDL and Client Location

1. Choose File Type
2. WsDL and Client Location

Specify the W3DL file of the web Service,

() Project: |

() Local File: |

1
() WSDLURL:  http:/flocalhost:3080/WebApplris/WebServiceTris 1 Service?wsD)| [l Set Provy... ]
| |

Specify a location for the dient,

BTS iris - Lycée Eiffel - Armentiéres
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NetBeans génére le paquetage pgtAccesWebServicelrisl. Les classes générées se situent dans le dossier
\WebServicelrislAppliTest\build\classes\pgtAccesWebServicelris1.

Les classes générées lors de I'importation sont

les suivantes :

#2 DireBonjour. class 1Ko Java Class
’?DireBDnjDurRespDnse.class 1Ko JavaClass
”ObjectFactDry.class Z¥Ko Java Class
'?package-infu.class 1Ko Java Class
9 wehServicelris1 . class 1Ko Java Class
#9 webServicelris1Service, class 2Ko Java Class

Les méthodes du service web sont visibles dans I'inspecteur de projet dans le dossier « Web Service

References ».

& | NetBeans IDE 5.5 - Web5ervicelris1AppliTest

5 |Projects 40 x | ‘Files : Runtime
u I:;El WiebApplris
ics
EI@ Source Packages
. G- pgtest
: ----@m"class:lFrame.java
1,_@ Test Packages
u_a Libraries
h-a Test Libraries
Elx._a Web Service References
EI@ WebServicelris1 5ervice
Eli WebServicelris15ervice
=B WebServicelrisiPort
- direBonjour

File Edit Wiew Mavigate Source Refactor Build Ru

BB =

5.4. Utilisation du service web dans I'application de test

Création de I'événement « onClick » sur le bouton JButtonl :
Dans l'affichage Design, clic droit sur le bouton JButtonl > Events > Mouse > mouseClicked

L’appel de la méthode direBonjour() du service web peut se faire de deux fagons :
» Cliquer — glisser la méthode a partir de I'inspecteur de projets vers le code souce

» Clic droit dans le code > Web Service
la méthode direBonjour() > OK

Client Resources > Call web Service Operation > Selectionnez

BTS iris - Lycée Eiffel - Armentiéres
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£ Select Operation to Invoke §|

fvailable Web Services;

= & WehServicelris1 AppliTest
—@ WebServicelris15ervice
—i Wb Servicelris1 Service
—E WebServicelris1Paork
@ direBonjour

K ] [ Cancel

Voila le code généré :

private void jButtonlMouseClicked(java.awt.event_MouseEvent evt) {

try { // Call Web Service Operation
pqtAccesWebServicelrisl_WebServicelrislService service = new
pgtAccesWebServicelrisl._WebServicelrislService();
pqtAccesWebServicelrisl_WebServicelrisl port =
service.getWebServicelrislPort();
// TODO initialize WS operation arguments here
jJava.lang.String prmNom = ""**;
// TODO process result here
jJava.lang.String result = port.direBonjour(prmNom);
System.out.printIn(*'Result = "+result);
} catch (Exception ex) {
// TODO handle custom exceptions here
}

Remarque : par souci de lisibilité, nous avons supprimé le nom du paquetage pgtAccesWebServicelrisl
devant chaque objet et nous avons importé le paquetage au début du code source :

import pgtAccesWebServicelrisl.* ;

Modifiez le code pour prendre en compte les éléments de I'interface graphique :
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private void jButtonlMouseClicked(jJava.awt.event.MouseEvent evt) {

try { /7/ Call Web Service Operation
WebServicelrislService service = new WebServicelrislService();
WebServicelrisl port = service.getWebServicelrislPort();
// TODO initialize WS operation arguments here
String nom = jTextFieldNom.getText();
// TODO process result here
JLabelReponse.setText(port.direBonjour(nom)) ;
} catch (Exception ex) {
// TODO handle custom exceptions here
}

Remarque : Pour insérer automatiquement la gestion des exceptions : clic droit sur la ligne > Surround with
Try-catch (génére aussi les importations de packages nécessaires)

Capture d’écran en fonctionnement :

Irig Arrmentigres | Appel Bonjour Iris Armentiéres

6. Déploiement sur un serveur d’application autonome

Notre serveur d’application de déploiement se trouve sur la machine distante 192.168.0.60.
Dans un navigateur web, il faut se connecter sur le port 4848 pour accéder a l'interface d’administration du serveur
d'application SJAS 9 :
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A Login - Microsoft Internet Explorer

Fichier ~ Edition  Affichage  Faworis  Qutils

ePrecedente - \J D @ :j

Rechercher ‘-‘}\{Favnrls @ B h\.ﬁ |_—| |_J ﬁ

Adresse @http:,f,|'192.168.0.ED:4848Iasadmin,l'admingui,l'TupFrameset mq o4 Liens

b

4
<
Java
Sun Java™ System Application Server
Administration Console
User Hame: | |
Password: | |
i
hs
< | =
@ Termine # Internct
La configuration par défaut du serveur d’application est la suivante :
» User Name = admin
» Password = adminadmin
» Domaine par défaut = domainl
Cliquez sur Applications > Web Applications > Deploy
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<3 Sun Java{TM) System Application Server Platform Edition 9.0 Admin Console - Microsoft Internet Explorer
Fichier  Edition  &ffichage  Faworis  OQutils 7

ePrécédente - \J @ @ {;j pRechercher “-E;:S-‘Favnris @ Dg%v .,i_; |£J_;| - |_J ﬁ

Adresse @ http: /192, 168.0.60: 4348/ asadmin) admingui/ TopFrameset

Chowe || version |

User: admin Server: 1582. 50 Domain: domain

Sun Java™ System Application Server Admin Console

Common Tasks Application Server = Applications = Yeb Applications
Application Semver . .
E Web Applications

AWeh application module consists of a collection of Wehb reso
Application Archive) file or directorny.

Deploved Web Applications (1)

< O3 Web Applications | Deloved Web Applications (1)
armserver \DQ Deploy... || )Jndeplny || Enahle || Dizakle |
4

= O Applications

3 Enterprize Applications

O EJBModules pplication Name 2 | Enal
E Connector Modules
O] | amserer true

[ O3 Lifecycle Modules
3 App Client Modules
+ & Wb Services
Custom MBeans
B B Resources
b [ Configuration

Il faut transférer sur le serveur d’application le fichier WAR du projet « WebApplris » :
Cliquez sur Parcourir pour sélectionner dans le dossier NetBeans du projet du service web :
\WebApplIris\dist\WebApplris.war

Commeon Tasks Application Server = Applications = Weh Applications

[ Application Server

= O3 Applications Deploy Web Module (Step 1 of 2) [ mext ]| cancel
0 Enterprise Applica Specify the location of an application to deploy. &pplications can be in packsdfed files, such
— 1 Web Applications as war, orin the standard Web Module directary farmat.
amserver
3 EJB Wodules Location: (&) package file to be uploaded to the Application Server.
3 Connector Module File To I\Prnjets_netheanSIWEbAppIrisIdianebApplris.war|[ Parcourir... ]
[» &3 Lifecycle Modules Upload:
C3 App Client Module: ) Package file or a directory path that is accessible fram the server.
= Q. YWeh Sepices File Qr Directory: | |

Custom MBAeans
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Cliquez sur Next

2 Sun Java(TM) System Application Server Platform Edition 9.0 Admin Console - Microsoft Internet Explo... |._||E

Fichier  Edition  Affichage  Faworis  OQukils 7

ePrécédente - \‘_.;J @ @ \::j pRechercher ‘-‘;n:.;-‘Favnris @ Bv .{_; ,y_fl - |_J ﬁ

Adresse @http:,f,|'192.168.0.ED:4848Iasadmin,l'admingui,l'TupFrameset b OK Liens

HOME WERSION UPGRADE REGISTRATION LOGOUT HELP

User: admin Server: 1 il Domain: domain é

Sun Java™ System Application Server Admin Console

Java"

Sun™ Microsystams, Inc.

Common Tasks Application Semver = Applications = YWeh Applications .
[ Applcation Server Deploy Web Module (Step 2 of 2) | Finish || Cancel
hi '3[:"':“;“““'_‘5 — * |ndicates required fiel
nterprise Applica
= [J Web Applications General
amsener File Hame: WekARDIS war
3 EJB Modules * Application Name: |WebAppIris |
3 Connector Modules Mame must contain only alphanumeric, underscore, dash, or dot characters
B 03 Lifecycle Modules * Context Root: |JWehAppIris |
3 App Client Modules Path relative to zerver's baze URL
w B ‘web Serices Virtual Servers: (server
Custom MBeans Aszociates an internet domain name with a physical server
I B Resources Status: [ Enabled
b [ Configuration Run: Clverier
Performn detailed verification befare deployving
Precompile: [JuzPs
Precompile JSPs, deploy only resulting class fies
Libraries: | |
Description: | | =
Add & description of the component 3
< T | &
@ Terming & Irtermet

Cliquez sur Finish et vérifier le résultat :
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2 Sun Java(TM) System Application Server Platform Edition 9.0 Admin Console - Microsoft Internet Explorer
Fichier  Edition  Affichage Faworis  Outils 7

ePrécédente < -_\_j @ @ \/_;j pRechercher ‘E‘n'\'g‘Favoris @ Bv .{_% @ < LJ ﬂ

Adresse @ http: /{192, 168.0.60:45348] asadmin) admingui/ TopFrameset

HOME “ERSION

User: admin Server: 1 1 G0 Domain: o

Sun Java™ System Application Server Admin Console

Common Tasks Application Sener = Applications = YWeh Applications

@ Application Serer Web Applications

= 8 Applications AWveb application module consists of a collection of Web resources such as JavaServer Fages (J5Fs), se
3 Enterprise Applications Application Archive) file ar directary.
= 1 Web Applications Deployed Web Applications (2)
amsener | Dieplay... || Undeploy | | Enable | | Dizakle |

WebAppls | | Application Name s | Enabled N | Context Root
3 EJB Modules O |amsemer true amserver
& Connector Modules \I L1 webapplris true MiehApnlris I

[ 23 Lifecycle Modules
3 App Client Modules
= @ Web Serices
B wehSenicelris1
Custormn MBeans
I B Resources
b [ Configuration

7. Utilisation du service web déployé sur le serveur distant
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